Memorex:

Is it live or is it Memorex?™

MMP8575
User’s Guide

2GB MP3/WMA
Digital Audio Player

Before operating this product,

please read these instructions completely.



PRECAUTIONS

COPYRIGHT:
» Distributing copies of MP3, WMA with DRM or WAV tracks without permission is a
violation of international copyright laws.

SAFETY:

» Vibration experienced during walking or exercising will not affect the player. However,
dropping the player or dropping a heavy object on the player may result in damage or
sound distortion.

*  Avoid spilling any liquid onto or into the player.

* Do not leave the player in a location near heat sources; in a location subject to direct
sunlight, excessive dust, sand, moisture, rain or mechanical shock; on an unlevel
surface; or in a car with the windows closed during periods of excessive heat.

ROAD SAFETY:

* Do not use headphones while driving, cycling or operating any motorized vehicle. It
may create a traffic hazard and it is illegal in some areas. It can be potentially
dangerous to play your headset at a high volume while walking, especially at pedestrian
crossings. You should exercise extreme caution or discontinue use in potentially
hazardous situations.

FCC WARNING:

* This equipment may generate or use radio frequency energy. Changes or
modifications to this equipment may cause harmful interference unless the
modifications are expressly approved in the instruction manual. The user could lose
the authority to operate this equipment if an unauthorized change or modification is
made.

This Class B digital apparatus complies with Canadian ICES-003.
Cet appareil numérique de la classe B est conforme a la norme NMB-003
du Canada.




FCC DECLARATION

This device complies with Part 15 of the FCC rules. Operation is subject to the
following two conditions: 1) This device may not cause interference, and 2) This
device must accept any interference received, including interference that may cause
undesired operation.

Warning: Changes or modifications to this unit not expressly approved by the party
responsible for compliance could void the user’s authority to operate the equipment.

NOTE: This equipment has been tested and found to comply with the limits for a
Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against harmful interference in a
residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions,
may cause harmful interference to radio communications.

However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful interference to radio or television
reception, which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following
measures:

» Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

» Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.

» Consult the dealer or an experienced radio/TV technician for help.

Shield cable must be used with this unit to ensure

compliance with class B FCC limits. Tested To Comply
C With FCC Standards
FOR HOME OR OFFICE USE




Dear Customer:

Selecting fine audio equipment such as the unit you've just purchased is only the start
of your musical enjoyment. Now it's time to consider how you can maximize the fun
and excitement your equipment offers. This manufacturer and the Electronic Industries
Association’s Consumer Electronics Group want you to get the most out of your
equipment by playing it at a safe level. One that lets the sound come through loud and
clear without annoying blaring or distortion and, most importantly, without affecting
your sensitive hearing.

Sound can be deceiving. Over time your hearing “comfort level” adapts to higher
volumes of sound. So what sounds “normal” can actually be loud and harmful to your
hearing. Guard against this by setting your equipment at a safe level BEFORE your
hearing adapts.

To establish a safe level:

« Start your volume control at a low setting.

» Slowly increase the sound until you can hear it comfortably and clearly, and without
distortion.

Once you have established a comfortable sound level:
+ Set the dial and leave it there.

Taking a minute to do this now will help to prevent hearing damage or loss in the future.
After all, we want you listening for a lifetime.

We Want You Listening For A Lifetime

Used wisely, your new sound equipment will provide a lifetime of fun and enjoyment.
Since hearing damage from loud noise is often undetectable until it is too late, this
manufacturer and the Electronic Industries Association’s Consumer Electronics Group
recommend you avoid prolonged exposure to excessive noise. This list of sound levels
is included for your protection.



Decibel

Level Example
30 Quiet library, soft whispers

40 Living room, refrigerator, bedroom away from traffic

50 Light traffic, normal conversation, quiet office

60 Air conditioner at 20 feet, sewing machine

70 Vacuum cleaner, hair dryer, noisy restaurant

80 Average city traffic, garbage disposals, alarm clock at two feet

THE FOLLOWING NOISES CAN BE DANGEROUS UNDER CONSTANT EXPOSURE:

90 Subway, motorcycle, truck traffic, lawn mower
100 Garbage truck, chain saw, pneumatic drill
120 Rock band concert in front of speakers, thunderclap

140 Gunshot blast, jet engine
180 Rocket launching pad

Information courtesy of the Deafness Research Foundation.




LOCATION OF CONTROLS

o1 W

1. Headphone Jack 7. Reset Button (Inside the
2. Display Recess Hole)
3. Navigation A Button 8. Volume + Button
4. Navigation «¢/Skip/Search ¢ 9. Volume - Button
Button 10. MENU/Lock Button
5. Navigation ¥ Button 11. Power On/Off/Stop Button
6. USB Jack 12. Enter/Play/Pause »11 Button

13. Navigation »/Skip/Search W
Button



POWER SOURCE

RECHARGEABLE BATTERY OPERATION

This unit comes with a built-in Lithium Polymer rechargeable battery. It is recommended that
the battery be fully charged before using for the first time and when the battery indicator at
the top right of the display becomes empty. Below are the icons which will give the
rechargeable battery status:

mERp [ p I_|

FULL 50% EMPTY

TO CHARGE THE BATTERY WITH THE COMPUTER

1. Connect the USB Cable to the USB port on the computer and the small end to the USB
port on the bottom of this unit. Press the Power On/Off/Stop button; the battery indicator
at the top right of the display will start filling with bars to indicate it is being charged.

2. When the battery is fully charged, the battery indicator will be full.

USB cable

NOTE:

» lttakes approx. three hours to charge the battery from empty to full. When fully charged,
the unit can playback for approx. 20 hours.

*  When charging the battery with your computer, you can only use your computer to
transfer files to the player; the player’s other functions will be unavailable.

*  When the battery is empty, if you connect the unit to the computer, it will start charging
automatically. If it does not start charging, press the Power On/Off/Stop button to
charge up the battery.



INSTALL “DIGITAL AUDIO PLAYER” SOFTWARE

TO INSTALL THE "DIGITAL AUDIO PLAYER" CD SOFTWARE

For Windows ME, Windows2000 or Windows XP:
Windows will automatically detect the audio player without installing the CD software
when the USB cable is connected.

For Macintosh OSX:
Macintosh OSX will automatically detect the audio player without installing the CD
software. Do not install the software when using a Macintosh.

For Windows98SE:

The USB mass storage function will not be activated without driver installation. To
activate the USB mass storage function, please use the installation CD-Rom to install
the driver.

For Windows 98SE, if you are connecting your player to your computer for the first
time, please follow these instructions:

Procedure to Install Player Driver  EELGCIICTS

1. Insert the Installation CD-Rom
into the CD Drive, then the
installation screen will appear. If
the installation screen doesn't
automatically appear, double-

click my computer then double- PMWW
click on the CD drive, then the

installation screen will appear.

Click on the Windows 98
firmware icon. Then click on the
MMP8575 icon.




S 98 DRIVER IN

Deco Setup

WIND

2. At the Welcome screen, click NEXT.

<o firm) [ cocn

Deco Setup
u

3. Read the License Agreement. If you accept
the terms of the license agreement, select o o v e
and dot the circle at the left of "I accept the S e
terms of the license agreement". Then click
NEXT.

4. At the Setup screen, click NEXT. It is
recommended to leave the destination folder
asitis.




WINDOWS 98 DRIVER INSTALLATION (CONTINUED)

5. At the Program Folder screen, click NEXT. It
is recommended to leave the program folder
as itis.

6. Click "Install" to start the installation.

7. When finished, the InstallShield Wizard
Complete screen will appear. Click FINISH to
exit the Install program and complete the
Windows 98 Driver installation.




WINDOWS MEDIA PLAYER 10 INSTALLATION

Windows Media Player 10 is for use with
Windows XP only. For Windows ME and
Windows 2000, please install Windows Media
Player 9. For Windows 98SE, please visit
www.Microsoft.com to download the
corresponding Windows Media Player for your
computer.
Once you have installed Windows Media Player
10, you can transfer MP3 files, WMA files, WMA
files with DRM 9 or DRM 10 to your player using
the “Sync” function.
1. Insert the Installation CD-Rom into the CD
Drive, then the installation screen will appear.
If the installation screen doesn’t automatically
appear, double-click “My Computer” then
double-click on the CD drive, then the
installation screen will appear. Click on the
Windows Media Player 10 Setup icon.

1 Chrono CD Installer

2. Installation will begin.

3. Read the License Agreement, then click |
ACCEPT.

F Y00 00 NOT AGREE, 06 NOT INSTALL OR USE THE SOFTWARE.
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WINDOWS MEDIA PLAYER 10 INSTALLATION (CON

4. |Installation will continue.

© Windows Media Player 10

ﬁ Welcome to Windows Media Player 10

5. At the Welcome screen, click NEXT. -

6. Select the desired privacy options.

11



Click on Privacy Statement to view the

Statement, if desired. When finished, click

Next.

Read the instructions and tick the check
boxes as desired. Then click on More

Options and tick the check boxes as desired.

Click “Finish” to finish the installation of the

Windows Media Player 10.
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DOWNLOADING AND TRANSFERRING FILES

TRANSFERRING FILES

You can download digital music files from the Internet or use encoding software to convert

music that you have on an audio CD into MP3 or WMA format. Once these files are stored

on your computer you can easily copy them to your player.

For Windows XP, if you already installed Windows Media

Player 10, you can transfer music files (MP3, WMA, WMA files TRANSFER MODE

with DRM 9 or DRM 10) to the player through the "Sync" function USE Connected

of Windows Media Player 10. Connect your computer to the USB Ready

port on your computer using the USB cable. "MPT Player" ,

"MMP8575" or "MMP8565" will appear in your "My Computer" folder which

indicates the player is connected. Also, the player will display the above figure. Then, follow

the procedure on page 16 to transfer music files to the player.

For Windows ME, Windows 2000, Windows 98 or Windows XP (without Windows

Media Player 10), transfer music files as follows:

1. Connect your player to the USB port on your computer using the USB cable as shown
on page 6.

2. A'"Removable Disk" window will automatically pop-up on your computer screen.

3. To add more files and songs to your player, simply drag and drop MP3 or WMA files
from anywhere on your computer into the "Removable Disk" window.

IMPORTANT: A WMA file with DRM 9 or DRM 10 will not play back if you directly drag and

drop it into the "Removable Disk" window. You must use Windows Media Player 10 to

transfer copy-protected files as described on page 16.

13



DOWNLOADING AND TRANSFERRING FILES (CONT.)

TRANSFERRING AUDIO FILES TO YOUR DIGITAL AUDIO PLAYER USING A
MACINTOSH COMPUTER

Make sure to use a Macintosh computer with an operating system of 10.0 or layer to
transfer audio files.

1. Turn on your computer.

2. Turn on your digital audio player.

3. Connect the smaller end of the cable to the USB jack on the player and the larger
end of the cable to the USB port on your Macintosh.

4. Your computer will automatically recognize your player and mount a hard disk icon
onto your desktop.

5. Locate the folder where your audio files are stored on your computer’s hard drive.
Simply drag and drop the audio files onto the mounted hard disk drive icon of your
digital audio player located on your desktop.

6. After you have finished your transfer, put away the digital audio player hard disk
icon(s) by dragging it to the Trash icon or Control-click its icon and choose Eject from
the File menu or select Eject from the File drop-down menu located at the top of your
screen. You can also use the keyboard shortcuts by selecting the digital audio player
hard disk icon and pressing the Command-E keys.

7. Your player is ready to play the files you transferred.

14



DOWNLOADING AND TRANSFERRING FILES (CONT.)

For Windows XP, you can also utilize the previously o :
installed Windows Media Player 10 software to *!'!!! i!ﬁ - —
convert music on an audio CD into MP3 or WMA > = G o - o

format as follows:

1. Open the Windows Media Player 10 Browser,
then click on the “Rip” icon on the top tool bar.
Insert a Music CD into the CD-Rom drive of your
computer.

NOTE: For Windows 98SE, Windows ME and

Windows 2000, please use the Windows Media

Player 9 to convert music on an audio CD into MP3 or

WMA format.
Options
2. Click on the “Tools” menu option at the top menu bar, i [ o
then click on “Options”; the Option setting menu will Y ek st o o
appear. Click on Rip Music and set the Rip Music to the S L ——
desired location on your computer. Then, set the desired

format for the newly ripped music (MP3 format or
Windows Media Audio format). Adjust the audio quality as
desired. When finished, click “OK” to confirm the settings.

3. Click on the “Rip Music” icon to start ripping the music to
your computer.

4.  When the music tracks are ripped; connect the player to
your computer. Open the "MPT Player" , "MMP8575"
or "MMP8565" window and open the ripped music location window.

5. To add the transferred/ripped music files/songs to your player simply drag and drop the MP3
and/or WMA files into the “MPT Player”, “MMP8575” or "MMP8565" window.

6. When the files are finished loading into the player, follow the “Safely Remove
Hardware” procedure as shown on page 17.

15



OWNLOADING AND TRANSFERRING FILES (CONT.

TRANSFERRING MP3/WMA FILES AND WMA
FILES WITH DRM 9 OR DRM 10 USING THE
WINDOWS MEDIA PLAYER 10 (FOR WINDOWS
XP ONLY)
To transfer MP3 files/WMA files/WMA files with DRM
9 or 10 to the player, follow the procedure described
below using the previously installed Windows Media
Player 10. Before beginning the procedure please
turn the unit on and connect the unit to the computer
as previously described.
1. Open the “Windows Media Player Browser 10”
and click on “Sync”.

o s b it s 5 o
Firr.

2. Click on the “Sync List” pull-down menu to
locate the music files you wish to download.
Then make sure to tick the box next to the files.

3.  Select the Portable Device ("MPT Player", "MMP8575"
or "MMP8565") that you want to copy to from the
right side drop-down menu. Click “Start Sync” to
start transferring music files to the player.

2 o), T T 457, 68518

4. After finished transferring all the desired files to
your unit, follow the “Safely Remove Hardware”
procedure on the next page.

NOTES:

. For WMA files with DRM 10, you can only use
Windows Media Player 10 to transfer files to
your player.

. For Windows ME and Windows 2000, please
use Windows Media Player 9 to transfer WMA
files with DRM 9 to the player. For Windows
98SE, please visit www.Microsoft.com to
download the corresponding Windows Media
Player to transfer music files to the player.

R

16




SAFELY REMOVE HARDWARE

SAFELY REMOVING YOUR PLAYER FROM THE COMPUTER
NOTE: To avoid damage to your player or data loss, always follow the procedure listed below
before disconnecting your player from the USB port on your computer.

Using your mouse, double click the "Safely Remove S
Hardware" icon on the task bar.

From the "Safely Remove Hardware" window, select "USB

Mass Storage Device" and click the "Stop" button. The 'Safely Remove Hardware' icon
"Stop a Hardware Device" window will pop-up as shown:
B
[ e
(] Display device comg onens
[ cem ) o Carcd_]

Click "OK". When the "Safe to Remove Hardware" window is displayed, you may remove the
player from the USB cable or remove the USB cable from the computer.

NOTES:

If the “Safely Remove Hardware” icon is not displayed on the task bar, please double click
on My Computer. Right click on “Removable Disk” and left click on “Eject”. Then it is safe to
remove the player from the computer.

The “Safely Remove Hardware” procedure is not necessary for Win98 and Win98SE users.
If you are using Windows XP and the Windows Media Player 10 software is already installed,
then you do not need to follow the above “Safely Remove Hardware” procedure.

17



OPERATION

TURNING THE POWER ON/OFF

LOCK SWITCH

Turn the unit on by pressing the Power On/Off/
Stop button; the Memorex start screen will
appear in the display temporarily. Then the
Music Player menu will appear and the
MP3/WMA track’s information will appear in
the display. To turn the unit off, press and hold
the Power On/Off/Stop button; “Hold Down To
Power Off” will appear in the display. The unit
will turn off after it counts up from one to three.
Do not release the Power On/Off/Stop button
until the unit turns off.

With the unit on, press and hold the MENU/Lock
button until LOCKED appears in the display; no
buttons will function. This is useful when you do
not want the track changed by accidentally
pressing a button. Press and hold the
MENU/Lock button until UNLOCKED appears in
the display to cancel the Lock function.

NOTE: After you have transferred music files to t
“Memorex” start screen will appear in the display

he player, when you turn on the player, the
temporarily followed by “Internal Updating

Music Library”. It will take several seconds to several minutes to update the player’s library
depending on the number of songs that you transferred to the player. When done, the Music

Player menu will appear in the display.

18




OPERATION (CONTINUED)

TO LISTEN TO MP3s/WMAs/WAVs

H g@

Turn the unit on by pressing the Power On/Off/Stop
button @; the Memorex start screen will appear in the
display temporarily. Then the Music Player menu will

Press the VOLUME +/- buttons @ to increase or
decrease the volume. To stop playback, press
the Power On/Off/Stop button @; the Stop

appear and the MP3/WMA's track information will
appear in the display. Press the Enter/Play/Pause
»11 button @ to start playback; the MP3 information
will appear/scroll across the display.

indicator will appear.

To turn the unit off, press and hold the Power On/Off/Stop
button; “Hold Down To Power Off" will appear in the
display. The unit will turn off after it counts up from one
to three. Do not release the Power On/Off/Stop button
until the unit turns off.

NOTE:

« See pages 7-16 for information on uploading MP3,

WMA and WAV files to this unit.

NOTE (AUTO RESUME): Each time you exit the Music Player mode or turn the unit off, when
the unit is turned back on or you enter the Music Player mode again, this unit will resume at the
beginning of the last track which was playing before turning the power off or changing mode.
There is no resume function for Shuffle Repeat mode.

19



OPERATION (CONTINUED)

TO PAUSE PLAYBACK

During playback, if you wish to pause the file
momentarily, press the Enter/Play/Pause Il
button; playback will pause, the Pause indicator will
appear and the timer will stop counting.

Press the Enter/Play/Pause »-1l button again to
resume playback; the sound will return, the Play
indicator will appear and the timer will start counting
again.

TO SELECT/BROWSE THROUGH THE FILES

H X

Press the MENU/Lock button @; the Main menu will
appear. Select the desired Browse option (Artist,
Genre, Album or All Songs) using the Navigation A
® or ¥ ® button, then press the Enter/Play/Pause
»11 button @. A list will appear separating the files
into the selected search criteria. At the next screen,
select the next desired option (for example, POP if
browsing by Genre) using the Navigation A @ or ¥
® button, then press the Enter/Play/Pause »11
button @. At the next screen, scroll through and
select a file using the Navigation A @ or ¥ @ button,
then press the Enter/Play/Pause »1l button @ to
select the music file and start playback of the file.

For the Browse option, see more details below:

Artist: All Artists will be shown in the display. Select the
desired Artist using the Navigation A @ or ¥ @ button, then
press the Enter/Play/Pause »Il button ®. All the Artist's
albums will appear; select the desired album using the
Navigation A ©® or ¥ @ button, then press the
Enter/Play/Pause »1l button ®. Then, select the desired
song using the Navigation A @ or ¥ @ button, then press
the Enter/Play/Pause »11button @ to start playback.
Album: All the albums will appear. Select the desired
album using the Navigation A @ or ¥ @ button, then press
the Enter/Play/Pause »-Il button ®. Then, select the
desired song using the Navigation A @ or ¥ @ button, then
press the Enter/Play/Pause »11button @ to start playback.
All Songs: The song’s name will appear in the display.
Select the desired song using the Navigation A @ or ¥V &
button, then press the Enter/Play/Pause »1l button ® to
start playback.

20




OPERATION (CONTINUED)

FORWARD/REVERSE SKIP

During playback, press the Navigation
»/Skip/Search W button to advance the player
to the beginning of the next file. Press the
Navigation »/Skip/Search W button repeatedly
to advance the player to higher-numbered files.

During playback, press the Navigation
<¢/Skip/Search 4 button to move the player
back to the beginning of the currently playing file.
Press the Navigation <¢/Skip/Search ¥4 button
repeatedly to move the player back to lower-
numbered files.

HIGH-SPEED MUSIC SEARCH

During playback, press and hold the
Navigation/Skip/Search <« / € @ or » / W &
button to move the player forward or backward
within a file to locate a specific musical passage.
The player will move forward or backward at
high speed as long as the button is held. When
you release the button, normal playback will
resume.

21




OPERATION (CONTINUED)

SETTING THE EQUALIZER

Press the MENU/Lock button @; the Main
menu will appear. Scroll to Settings using the
Navigation A @ or ¥ @ button then press the
Enter/Play/Pause »11button @ to select it.

Scroll to Equalizer using the Navigation A @ or
V¥ ® button then press the Enter/Play/Pause »1l
button @ to select it.

Select a desired EQ setting (Normal, Rock,
Jazz, Classical, Pop or X-Bass using the
Navigation A @ or ¥ @ button then press the
Enter/Play/Pause »1l button ® to select it.

Press the Navigation <¢/Skip/Search 44 button
twice to exit the menus. The selected EQ mode
will appear at the top of the display.

NOTE: You can also press the MENU/Lock
button twice to exit and return to the Music
Player menu . Also, if no button has been
pressed for 25 seconds, the unit will
automatically return to the Music Player menu.
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OPERATION (CONTINUED)

SETTING THE PLAY MODE

Press the MENU/Lock button @; the Main
menu will appear. Scroll to Settings using the
Navigation A ® or ¥ ® button then press the
Enter/Play/Pause »11 button @ to select it.

Scroll to Play Mode using the Navigation A @ or
V¥ @ button then press the Enter/Play/Pause »ll
button @ to select it.

Select the desired Play mode using the

Navigation A @ or ¥ @ button, then press the

Enter/Play/Pause »1l button ® to select it.

Normal: Normal playback

Repeat Track: Repeats the current track

Repeat All: Repeats all of the files

Shuffle: Randomly plays the files once
and then stops

Shuffle Repeat: Randomly plays all the files
repeatedly

Press the Navigation <¢/Skip/Search K¥{ button
twice to exit the menus. The selected Play mode
symbol will appear at the top of the display.




OPERATION (CONTINUED)

SETTING THE CONTRAST

Press the MENU/Lock button @; the Main
menu will appear. Scroll to Settings using the
Navigation A @ or ¥ ® button then press the
Enter/Play/Pause » 1l button @ to select it.

Scroll to Contrast using the Navigation A @ or ¥
® button then press the Enter/Play/Pause »1l
button @ to select it.

Press the Navigation » @ to increase or
Navigation <« ® button to decrease the
contrast, then press the Enter/Play/Pause »11
button &.

Press the Navigation <¢/Skip/Search 44 button
twice to exit the menus.
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OPERATION (CONTINUED)

SETTING THE BACKLIGHT

Press the MENU/Lock button @; the Main
menu will appear. Scroll to Settings using the
Navigation A @ or ¥ © button then press the
Enter/Play/Pause »1l button @ to select it.

Scroll to Backlight using the Navigation A @ or
V @ button then press the Enter/Play/Pause »1l
button @ to select it.

Press the Navigation A @ or ¥ @ button to
select the desired backlight time (time the
backlight will stay on after a button is
pressed—Off, 3 seconds, 5 seconds, 10 seconds
or Always On), then press the Enter/Play/Pause
» 1l button ©.

Press the Navigation <¢/Skip/Search M{ button
twice to exit the menus.

N
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OPERATION (CONTINUED)

SETTING THE POWER SAVINGS

Press the MENU/Lock button @; the Main
menu will appear. Scroll to Settings using the
Navigation A @ or ¥ ® button then press the
Enter/Play/Pause »11 button @ to select it.

Scroll to Power Savings using the Navigation A
® or ¥ @ button then press the Enter/Play/
Pause »-11button @ to select it.

Press the Navigation A @ or ¥ @ button to
select the desired Power Savings (time the unit
will stay on before turning off due to inactivity
—Disable, 1 Minute, 3 Minutes or 5 Minutes),
then press the Enter/Play/Pause » 11 button ©.
NOTE: Select Disable to disable this feature
and not have the unit enter the Power Savings
mode.

Press the Navigation <¢/Skip/Search 44 button
twice to exit the menus.
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OPERATION (CONTINUED)

SETTING THE LANGUAGE

Press the MENU/Lock button @; the Main
menu will appear. Scroll to Settings using the
Navigation A @ or ¥ ® button then press the
Enter/Play/Pause »-11button @ to select it.

Scroll to Language using the Navigation A @ or
V¥ @ button then press the Enter/Play/Pause »1l
button @ to select it.

Press the Navigation A @ or ¥ @ button to
select the desired Language the text on the
display will be in (English, Traditional Chinese,
Spanish, ltalian, French, Dutch or Japanese),
then press the Enter/Play/Pause » 11 button ©.

Press the Navigation <€/Skip/Search 44 button
twice to exit the menus.
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OPERATION (CONTINUED)

TO VIEW THE SYSTEM INFO (ABOUT)

Press the MENU/Lock button @; the Main
menu will appear. Scroll to Settings using the
Navigation A @ or ¥ @ button then press the
Enter/Play/Pause »11button @ to select it.

Scroll to About using the Navigation A ® or V &
button then press the Enter/Play/Pause »II
button @ to select it. The unit will then display the
Version, Internal media (the total internal
memory) and Internal Free Space.

Press the Navigation <¢/Skip/Search ¥4 button
three times to exit the menus.

2
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TROUBLESHOOTING GUIDE

If you experience a problem with this unit, check the chart below before calling for service.

inserted.

SYMPTOM CAUSE SOLUTION
Unit will not Battery is low/empty. Recharge battery as
turn on. described on page 6.
Unit is not turned Press Power On/Off/Stop
on. button to turn the unit on.
No sound. Headphones are not Insert headphones.

Volume is set too
low.

Raise the volume using the
Volume + button.

The MP3 or WMA files
are corrupted.

Download uncorrupted
files.

No files are in the
player.

Upload files to the unit as
described on pages 13-16.

The computer is not
recognizing the
player.

The player is
not securely connected.

Make sure player is
securely connected.

Win98 Driver isn't installed
or computer is not
compatible.

Install Win98 driver and/or see
pages 7-12 for
compatibility.

WMA files with DRM
can’t playback.

Incorrect downloading
methods.

See page 16 to download
WMA files with DRM.
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TROUBLESHOOTING GUIDE (CONTINUED)

SYMPTOM CAUSE SOLUTION
No buttons work. The Lock feature is Deactivate Lock feature as
activated. described on page 18.

Unit needs to be reset |Reset unit and/or

or firmware needs to be|update firmware, see
updated. pages 31-32.

Unit acting erratically. | Unit needs to be reset |Reset unit and/or

or firmware needs to be|update firmware, see
updated. pages 31-32.
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FORMATTING THE PLAYER

Formatting the Player
WARNING! Do not format this player unless it stops working and you are
instructed to do so by technical support personnel.

1.

3a.

3b.

Use the USB cable to connect the
player and the computer.

Double click on My Computer, then
right click "MPT Player", "MMP8575"
or "MMP8565" or "Removable Disk"
and left click on "Format".

For "MPT Player", "MMP8575"

or "MMP8565" at the "Format" window,
click OK to confirm and the player
will start to format (see figure to the
right).When finished,click "OK" to
close the Format window.

Format demavabln Disk (£:) [ 0)

Capaciy
1966 -
[

Fare

Mocatson unk sce

Detaukt slocaren sce v

Vo el

e
Quid Fornat

Format window for
"Removable Disk"

Format window for
"MPT Player",
"MMP8575" or
"MMP8565"

For "Removable Disk", at the "Format" window, select "FAT 32" from the
file system pull-down menu, then click "Start" to format the unit (see

figure above).

NOTE: Make sure you have selected "FAT 32" at the file system pull-
down menu; otherwise, after formatting, the player will not work properly.
Then, click OK to confirm and the player will start to format. When
finished, click "Close" to close the Format window.
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UPDATING THE FIRMWARE

WARNING! Do not update the firmware unless you are experiencing problems with
your digital audio device. Incorrect or faulty firmware installation will cause the player
to stop functioning.

1.
2.

3.

RESETTING THE UNIT

Download the updated firmware at www.memorexelectronics.com.

Unzip the file, then double click setup.exe in the Desktop folder to install the
software to your computer.

Connect the player to the computer using the supplied USB cable and the
installation screen will appear. (If the installation screen does not appear, unplug
the USB cable and turn off the unit). Connect to the computer again and press and
hold the Power On/Off/Stop button until the installation screen appears.

Follow the on-screen instructions to install the driver.

When finished, click START and locate the newly installed software “Deco” and
select “Firmware Download”.

If the unit acts erratically, reset the unit by inserting a thin object (such as a paper clip)
into the recessed RESET button. For the RESET button, see page 5 for the button's
location.



SPECIFICATIONS

Audio Frequency Range 20Hz — 20KHz
Headphones Output 5mW, 32ohm (Max. Vol)
S/N Ratio 85db (MP3)
File Support MP3 MPEG 1/2/2.5 Layer 3
WMA Windows Media Audio (WMA file with
DRMS9 or DRM 10)
Bit Rate 32kbps—320kbps (MP3)
32kbps—192kbps (WMA)
General Dimension 1.8 (W) x 3.2 (H) x 0.6 (D) inches
Weight 1.7 ounces
usB USB 2.0
Built-in Memory 2GB
Max. Playtime Approx. 20 hours
Supported OS Win ME, 2000, XP and Mac OSX

Win 98SE (Driver is required)
Operating Temperature  23° F to 104° F (-5° C to 40° C)
Rechargeable Battery Li-Polymer Rechargeable Battery
DC 3.7V, 530mAh

Specifications are subject to change without notice.
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FOR FIRMWARE UPGRADE, PLEASE VISIT OUR WEBSITE AT
WWW.MEMOREXELECTRONICS.COM
TO CHECK IF THERE IS NEW FIRMWARE AVAILABLE.

FOR ADDITIONAL SET-UP OR OPERATING ASSISTANCE,
PLEASE VISIT OUR WEBSITE AT

WWW.MEMOREXELECTRONICS.COM
OR CONTACT CUSTOMER SERVICE AT (954) 660-7100.

PLEASE KEEP ALL PACKAGING MATERIAL FOR AT LEAST 90
DAYS IN CASE YOU NEED TO RETURN THIS PRODUCT TO YOUR
PLACE OF PURCHASE OR TO MEMOREX.

FOR PARTS AND ACCESSORIES, CONTACT FOX INTERNATIONAL
AT 1-800-321-6993.
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Memcorp, Inc.
Weston, FL
Printed in China

Visit our website at www.memorexelectronics.com
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